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Overview

The following subsection gives you information that you need to prepare your 
system for installing a RocketPort adapter.

How to Use this Document

You can use the interactive Table of Contents to locate the information you need.

Driver Requirements

This document discusses installing and configuring the RocketPort and 
RocketModem device driver for the Windows NT operating systems:

• Microsoft® Windows® NT  4.0

• Citrix® WinFrame® (1.8) 
This driver supports the following products:
• RocketPort ISA
• RocketPort PCI (4J, 8/16/32-port, and Quad/Octacable models)
• RocketPort Universal PCI (Quad/Octacable models)
• RocketPort Universa PCI Low Profile (4 and 8-port)
• RocketPort PCI/422
• RocketPort 485
• RocketPort Plus (2, 4, 8-port andvQuad/octacable)
• RocketModem ISA
• RocketModemII PCI
Note: The readme.txt file that is delivered with the driver may contain additional 

information not published in this document.
Driver updates can be downloaded at no charge from the Comtrol ftp/web site. 
Always check the web or ftp sites to make sure that you have the current driver 
and documentation. Software downloaded from the ftp/web site are self-extracting 
zipped files that you must extract before installing.

Locating Hardware Installation Documentation

For hardware specific information or product information, see the hardware 
installation documentation that is available on the Comtrol CD shipped with your 
product, or you can download the current version from the ftp/web site.
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Installation Prerequisites
Installation Prerequisites

Before you begin installation, note the following:
1. You must have at least one RocketPort or RocketModem adapter installed 

before installing this driver. See the Locating Hardware Installation 
Documentation discussion.

2. If you are using Windows NT 3.51 or an early version of Windows NT 4.0 with 
no service packs applied, and are using the adapter to provide dial-in (RAS) 
access to the NT server, verify that NetBEUI is installed before installing 
RAS.
Note: Under Windows NT 4.0, RAS will not work properly unless you have at 

least Service Pack 5 applied. For more information about service packs 
and updates, contact Microsoft.

3. If you are installing the RocketPortModem in a system without an existing 
network adapter (NIC), you must install network services and the Microsoft 
Loopback Adapter software first. See your Microsoft Windows NT 
documentation for more information.

4. If you are using this driver under Windows NT 3.51, or if you are using the 
modem.inf file under NT 4.0, be advised that the driver installation process 
creates a backup of the modem.inf file named modem.bak, before updating the 
file.

5. Finally, if you are upgrading from an earlier version of the RocketPortModem 
device driver, you must remove the old driver before installing this new 
version. Do not use the Update option.
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Driver and Adapter Information

The following subsections discuss driver and adapter installation and removal. It 
also discusses adapter and port configuration. If you have installation problems, 
see the troubleshooting subsection.

Removing an Existing Driver

Use the following procedure to remove an existing Windows NT driver. If you are 
updating (not reconfiguring) this driver, make sure that you remove the existing 
driver before installing the new driver.
1. Open the Control Panel and double-click on the Network icon.
2. Select the Adapters tab.
3. Highlight Comtrol RocketPort, 

RocketModem.
Note: If Comtrol 

RocketPort,RocketModem 
does not appear in the 
Adapters window, select the 
Cancel button, and then go to 
the Special Instructions on 
Page 8.

4. Select the Remove button. You 
are asked to verify the deletion.

5. Select the Yes button. The 
selected item is deleted.

6. Select the Close button. Several 
windows are displayed as the 
system updates its 
configuration.
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Special Instructions
7. Select the Yes button to shut down and restart the system, so that your 
changes take effect.

8. After removing the existing driver, see the Installing the Device Driver 
discussion.

Note: This procedure does not remove the Comtrol RocketPort RocketModem 
program group. If you wish to do so, see the “Start Menu” topic in the 
Windows NT help system for more information.

Special Instructions If Comtrol RocketPort,RocketModem does not appear in the Adapters tab, select 
Cancel to exit from the Network window. Then start the Comtrol RocketPort/
RocketModem Setup program, set the droplist for each board to Not Installed, and 
save the changes and reboot.
This should remove the driver and clean up all associated files. If it does not 
resolve the situation, contact Comtrol Technical Support for more assistance.

Installing the Device Driver

Use the following instructions to install the RocketPort/RocketModem Windows 
NT driver.
Note: If you are updating the Windows NT driver, remove the existing driver first. 

Do not use the Update option.
These procedures assume that you have already installed the hardware and 
determined that it is working properly. If you have not done so, you can use the 
Hardware Installation Document for help in installing the hardware.
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Driver Installation
Driver Installation After you have extracted the driver files (if needed), follow these steps:
1. Open the Control Panel and double-click the Network icon, or right-click on the 

Network Neighborhood icon and select the Properties button.

2. Select the Adapters tab.
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Driver Installation
3. Select the Add button. The list of supported network adapters appears: 

4. Select the Have Disk button.
5. If you are installing the driver from a diskette, insert the diskette.

Note: Make sure that you have extracted the files from the Comtrol media or 
any downloaded file from the ftp/web sites.

6. Enter the drive and directory path to the installation files, and select the OK 
button.

For example, if you used the self-extractor utility to create a c:\comtrol 
directory, enter: 

c:\comtrol

7. Select the OK button with Comtrol RocketPort/RocketModem highlighted.
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Driver Installation
8. Select the Next button when the Add Device Wizard appears and follow the on-
screen instructions to configure the adapter type you installed in your system. 
You must install and configure at least one adapter at this time. If you are 
installing more than one adapter, install all PCI-bus adapters before installing 
any ISA-bus adapters.

Depending on the model of adapter you have installed, enter the following 
information.
Note: The prompts that display and the options associated with each prompt 

change depending on your selections. If you reach a point where the 
available options do not match your product, you probably selected an 
incorrect choice on an earlier page. In this case, select the Back button to 
backtrack and review your selections, and correct as needed.

a. Bus Type. Select ISA or PCI, and select the Next button.
b. Model. Use the droplist to select the Comtrol product you have installed, 

and select the Next button.
c. Number of Ports. Use the droplist to select the number of ports on the 

product you have installed, and select the Next button.
d. Base I/O Address. (ISA-bus products only.) Use the droplist to select the 

I/O address you set using the DIP switches on the adapter. (See the 
Hardware Installation Document.)
If you are installing a PCI adapter and this prompt appears, you selected 
the wrong Bus Type in Step a. Select the Back button to go back and change 
your selection.

e. Country. (Comtrol modem products only.) Use the droplist to select the 
country or region where the modem will be used.
Note: Not all Comtrol modem products support all country selections. 

Check your packaging to make sure that your modem supports the 
country you wish to select.
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Driver Installation
9. When you have finished entering adapter configuration information, select the 
Finish button. The appropriate Device Setup tab appears:   

10. Review the information shown. If desired, you can enter a more descriptive 
name for the adapter, change the base I/O address setting (ISA-bus only), or 
change the COM number assigned to the first port on the adapter.

11. Select the OK button to save the device configuration. The Main Setup tab 
appears:

12. If you have installed more than one adapter, you may configure more adapters 
at this time. Select the Add button, then repeat Steps 8 through 11 for each 
additional adapter installed.

RocketPort PCI Example
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Driver Installation
Note: If you are installing more than one adapter, install all PCI-bus adapters 
before installing any ISA-bus adapters.

13. If you have installed a RocketPort adapter that is capable of speeds over 230.4K 
bps, you can configure the driver for high-speed operation at this time. Follow 
these steps:
a. Select the Options tab.
b. Use the Scan Rate droplist to select a driver servicing rate. For example, to 

use an Octacable at 460.8K bps, select 4. To use a RocketPort Plus at 
921.6K bps, select 2 or 1.
For more information about the Options tab and Scan Rate control, see 
Changing or Viewing Driver Configuration.

c. Select the Main Setup tab. The Device Setup tab reappears.
14. Select the OK button to close the Setup window. 
15. Select the Yes button when the confirmation window appears, asking you to 

verify that you want to save the configuration and exit. The setup process 
creates and displays the program group:

16. Select the OK button when this reminder appears.

17. Select the Close button when the Network Adapters window appears, showing 
the Comtrol adapter.

18. Select the Yes button to shut down and restart the server, or the No button to 
put it off until a more convenient time.

Note: You must shut down and restart the server before your changes take 
effect. Do not use the Comtrol Setup program until you have done so.
Driver and Adapter Information 13 



Verifying Installation
Verifying 
Installation

After you shut down and restart the server, access the Windows NT 
Administrative Tools menu and open the Event Viewer. 

If the installation was successful, there is an “i” type log entry stating that 
the driver successfully initialized the hardware.
If the installation failed, there is a stop or “!” type event log entry. Double-
click on the log entry for more information. If the Verbose Event Log option is 
enabled, additional details may be listed.
If the cause of the problem is not immediately apparent, see the discussion 
on Troubleshooting on Page 44.

Further 
Configuration

After you restart the server:
• If you are using a standard RocketPort or RocketPort Plus, review the 

information under Changing or Viewing Port Configuration and fine-tune the 
port configuration as needed. Then proceed with installing and configuring 
peripheral devices.

• If you are using a RocketModem, review the information on Modem Reset 
under Changing or Viewing Port Configuration. Then proceed with configuring 
the modems.

• If you are using a RocketPort 485 or an external RS-485 converter, you must 
configure both the driver and the individual ports for RS-485 operation. See 
Changing or Viewing Driver Configuration for information on enabling RS-485 
at the driver level, then Changing or Viewing Port Configuration for 
information on enabling RS-485 on selected ports.
Driver and Adapter Information 14 



Changing or Viewing Driver Configuration
Changing or Viewing Driver Configuration

To view or change the driver configuration after installation, follow these steps:
1. Use one of these methods to start the Comtrol Setup program:

a. From the RocketPort/RocketModem program group, double-click on the 
RocketPort Setup icon.

b. From the Start button menu, select Programs, then Comtrol RocketPort/
RocketModem, then RocketPort Setup command.

c. From the desktop, right-click on the Network Neighborhood icon and select 
Properties. The Network window appears. Select the Adapters tab, then 
select Comtrol RocketPort, RocketModem from the Network Adapters list. 
Then select the Properties button.

2. Select the Options tab.
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Changing or Viewing Driver Configuration
3. Select, clear, or set the following as desired:

a. Verbose Event Log. Select this check box to cause longer messages to be 
sent to the Windows NT Event Log. This added information can be useful 
when debugging communications and configuration problems.

b. Scan Rate. Use this droplist to set the driver servicing rate. As a general 
rule this is changed only if you are driving ports at rates in excess of 230.4 
Kbps. For example, if you are using a RocketPort OctaCable running at 
460.8 Kbps, select 4 ms. If you are running a RocketPort Plus at 921.6 
Kbps, select 2 ms.

Note: Earlier versions of the Comtrol Windows NT driver also required an 
interrupt (IRQ) setting in order to achieve high baud rates. The 
improved servicing routine in the 4.x driver no longer requires an IRQ.

c. If you are using a RocketPort 485, or if you are using a standard 
RocketPort with an external RS-232 to RS-485 converter, select the Enable 
RS-485 check box to permit RS-485 operation, and you want to use RS-485 
mode. If you are not using RS-485, leave this box box blank.

Note: This sets the driver to support RS-485. You must also configure each 
port that you plan to use for RS-485.

4. When you are done working with the driver configuration options, select the 
Main Setup tab to return to the Main Setup window, or the OK button to save 
your configuration changes and exit.
Changes to RS-485 status take effect immediately on exit. Changes to the scan 
rate or event log status require that you save your changes and restart the 
server before your changes take effect.
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Changing or Viewing Adapter Configuration
Changing or Viewing Adapter Configuration

To view or change adapter configuration after installation, follow these steps:
1. Start the Comtrol Setup program. The Main Setup tab appears:

2. In the Configuration list, select on the adapter you want to work with and 
select the Properties button.

Note: The Summary group displays the basic device configuration, as entered 
using the Add Device Wizard. If this information is not correct, you 
must remove and re-add the device.

3. You can view or change the following as desired:
a. Name. The default device name is assigned by the Add Device Wizard. If 

desired, you can enter a more descriptive name.
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Changing or Viewing Adapter Configuration
b. Base I/O Address. (ISA-bus adapters only.) If desired, use the droplist to 
select a different base I/O address.
If this is the first ISA-bus adapter in the system, the I/O address DIP switch 
setting on the adapter must match the DIP switch illustration shown to the 
right of the entry field.
If this is the second or subsequent ISA-bus adapter, you may select any 
available I/O address range. The address you select here does not have to 
match the DIP switches on the adapter.
However, the DIP switches on second and subsequent adapters must be set 
in correct relation to the DIP switch settings used on the first adapter, as 
described in the hardware installation instructions.

c. Starting COM Port. Use the droplist to select the COM port number to 
assign to the first port on the adapter. All other port numbers will follow in 
sequence.
If you have more than one adapter installed, the numbering on subsequent 
adapters will follow from the first adapter. (For example, if the first adapter 
has COM5 through COM12, the second adapter will begin with COM13.)
If desired, you can use this control to set nonsequential starting COM port 
numbers for each adapter, thus leaving gaps in the COM port numbering 
sequence.
Do not use this control to overlap COM port numbers. If you do so, the 
overlapping ports will be disabled.

4. When you are done, select the OK button to close the Device Setup tab and 
return to the Setup window.
Your changes are not saved until you select the OK button to save and exit 
from the Setup window. When you do so, your changes take effect immediately. 
No reboot is required.
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Changing or Viewing Port Configuration
Changing or Viewing Port Configuration

To view or change individual port configuration, follow these steps:
1. Start the Setup program. The Main Setup tab appears:

2. If necessary, click the [+] button in front of the adapter name so that the ports 
on the adapter are displayed.
Note: To hide the list of ports, click the [-] button in front of the adapter name.

3. In the Configuration list, select the port you want to work with. Then select the 
Properties button.
The COM Properties window appears:  
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General Port Setup
Note: The tabs and options present in this window depend on the adapter 
model and driver options selected.

4. View or change the port properties as desired. For reference, see the following 
discussions. When you are done, select the OK button to close the Port Setup 
tab and return to the Main Setup tab.
If you have selected the Clone check box, the changes you make are applied to 
all Comtrol ports controlled by this driver.
Your changes are not saved until you save and exit from the Main Setup tab. 
When you do, your changes take effect immediately. No reboot is required.

General Port Setup Override and lock baud rate
This option replaces the Baud Rate Mapping option used in earlier versions of 
this driver, and lets you lock selected ports to specific baud rates. After you do 
so, no matter what baud rate is selected in a host application, the actual rate 
used is the rate specified here.
Note: Not all rates are supported by all Comtrol products. See your hardware 

documentation to determine if your adapter supports the desired rate. 
To use rates above 230.4 Kbps, you must also reset the scan rate 
(page 15).

Timeout on transmit data on port close
Use this droplist to select the length of time to wait for data to clear the 
transmit buffer after a host application has closed the port.
This is typically used with peripheral devices such as printers, to give the data 
sufficient time to flush through the system.

Map CD to DSR
This option is used in installations where there is no connection to the port’s 
DSR input. Select this check box to cause the CD input to appear as DSR to 
the host application, and to perform hardware handshaking with CD rather 
than DSR. This is ignored if flow control is not enabled via 
IOCTL_SERIAL_SET_HANDFLOW.

Map 2 stop bits to 1
If the application you use is hardcoded to use two stop bits and you receive 
framing errors, select this check box to map 2 stop bits to 1 bit.
Otherwise, leave this box unchecked.

Wait on physical transmission before completing write
This option forces all write packets to wait until the transmit data has 
physically completed the transmission before returning completion to the host 
application. The default mode (check box not selected) is to buffer the data in 
the transmit hardware buffer, and return completion as soon as the packet is 
in the buffer.

Emulate modem hardware RING signal
Select this check box to emulate the ring indicator signal. If this feature is 
enabled, the driver monitors the data stream and outputs a software RI 
whenever the “ring” AT command is received.

Clone
If this check box is not selected, changes apply to the selected port only.
If this check box is selected, changes apply to all Comtrol ports in the system. 
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RS-485 Tab
RS-485 Tab This tab appears if RS-485 is enabled in the driver Options tab. Use it to enable 
and configure RS-485 on specific ports. 

If you want to use RS-485, you must have:
• hardware that supports RS-485, and
• RS-485 enabled on the Options tab and the individual port.
Override and lock to RS-485 toggle mode

Select this check box to switch the selected port to RS-485 mode.
RS-485 Toggle RTS Low

Select this check box to toggle the RTS output signal low during data 
transmission. If this box is not checked, RTS is toggled high (asserted) during 
data transmission.

Modem Tab This tab appears if the selected port is a Comtrol modem product.
There is one control: the 
Reset button. To reset the 
selected modem to its default 
(power-on) state, select the 
button.
This resets only the modem 
on the selected COM port, on 
the selected adapter. This 
option cannot be used to 
reset non-Comtrol modems.
Note: Some Comtrol 

modems do not 
support reset. To 
determine whether 
your modem supports 
Reset, see the readme 
file.
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Adding an Adapter
Adding an Adapter

To add adapters to an existing installation, follow these steps:
1. Shut down the server, switch off the power, and remove the cover.
2. If you are installing an ISA-bus adapter, set the I/O address DIP switches as 

indicated in the hardware installation instructions.
3. Install the new adapter in an available slot of the correct bus type.
4. Replace the cover and power up the server.
5. Start Windows NT and log in as the system administrator.
6. Start the Setup program. The Main Setup tab appears.
7. Select the Add button.
8. The Add Device Wizard starts. Follow the instructions on-screen to configure 

the newly installed adapter. When the wizard finishes, you are returned to the 
Setup window.

9. Select the OK button to save and exit from the Setup program.
10. Shut down the program and restart the server, so that your changes take 

effect.

Removing an Adapter

To remove an adapter, follow these steps:
1. Start the Setup program. The Main Setup tab appears.
2. In the Configuration window, select on the adapter to be removed.
3. Select the Remove button.

To change your mind, select the Cancel button immediately. When you re-enter 
the Setup program, the adapter is restored.

4. To permanently remove the selected adapter, select the OK button to save and 
exit from the Setup window.
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Windows NT Configuration Overview

Configuring Modems

After installing the hardware and driver for Windows NT, you can use this 
discussion to configure modem COM ports.
The Comtrol device can support any asynchronous serial modem for use by any 
application that uses TAPI. For information regarding port pinouts and signals, 
see Locating Hardware Installation Documentation on Page 5.

Working with NT 
RAS

Comtrol products are frequently used to provide Dial-Up Networking access with 
NT RAS (Remote Access Service). 
• If RAS is not installed, note that you must install at least one RAS-capable 

device (for example, modem) before installing and configuring RAS.
• If RAS is installed, note that the modem installation process automatically 

launches RAS Setup after modem installation is complete.

Installing Modems The following instructions were developed using Comtrol modem products. If you 
are using another brand of modem, note that some prompts and window 
descriptions may differ from those shown.
Follow these steps:
1. Connect the modem to the desired port. 
2. Power up the modem.
3. Open the Control Panel window.
4. Double-click the Modems icon.

If you have no other modems installed, skip to Step 5.
If you have already installed another modem, the Modems Properties window 
appears. Select the Add button. The Install New Modem wizard appears.
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Installing Modems
5. Check the “Don’t detect my modem...” box and select the Next button.

Note: While Windows NT can automatically detect modems, we advise against 
using this option as auto-detect feature may cause some multiprocessor 
systems to lock up, and the modems may be installed in reverse order.

6. Select the appropriate manufacturer and model and selec the OK button. If 
the correct manufacturer and model do not appear on the list, select Have Disk 
to install software from a manufacturer-supplied installation diskette.

7. Select the COM port number.
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Further Modem Configuration
8. Select the Finish button. The modem software is installed on the selected ports.

Depending on prior configuration, you may be asked to enter your country of 
use, area code, the number you dial to get an outside line, and whether you 
have tone or pulse dialing at this time.

9. If you need to configure modem 
properties (maximum baud rate, data 
bits, parity, and so on), select the 
Properties button, make the needed 
changes, then select OK to return to this 
window.
Note: For help configuring modem 

properties, see the Windows Help 
System.

10. If you need to configure dialing 
properties (country, area code, calling 
card number, and so on), select the 
Dialing Properties button, make the 
needed changes, then select the OK 
button to return to this window.

11. Select the Close button.

Further Modem 
Configuration

At this point:
• If you are not using RAS, you are now finished. Reboot the system so that your 

changes take effect and resume normal operations.
• If you plan to use RAS but do not have it installed yet, reboot your system, 

then go to Installing RAS Initially.
• If you already have RAS installed and configured, this dialog box appears. 

If you do not want to configure this modem for use with RAS at this time, 
select the No button, then reboot and resume normal operations.
If you do want to configure this modem for use with RAS, do not reboot. 
Instead, select the Yes button, then go directly to Adding or Reconfiguring a 
RAS Device.
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Installing and Configuring RAS
Installing and Configuring RAS

After installing the hardware and driver, and installing and configuring at least 
one RAS device (for example, a modem), use this section to install and configure 
Remote Access Service (RAS).

Installing RAS 
Initially

If you have not previously installed RAS in your Windows NT system, log into the 
system with Administrative rights and follow these steps:
Note: This example shows how to install and configure RAS for use with modems, 

but you can use it as a guide to setting up other serial devices.
1. Open the Control Panel and double-

click the Network  icon, or right-click 
on the Network Neighborhood and 
select the Properties button.

2. Select the Services tab, and select the 
Add button. 

3. Highlight Remote Access Service, 
and select the OK button.
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Adding or Reconfiguring a RAS Device
4. Enter the location of the 
Windows NT files (for example, 
d:\i386) and select the Continue 
button. 
The appropriate files are copied 
onto your hard drive.
The RAS installation process 
automatically launches the Add 
RAS Device process. Go to 
Adding or Reconfiguring a RAS 
Device, Step 5.

Note: If you install or reinstall RAS from your original Windows NT 4.0 
distribution media, you must install or reinstall the latest Windows NT 
Service Pack after installing/reinstalling RAS. This is necessary because 
most Service Packs include RAS-related files that are newer than the files on 
the NT distribution media.

Adding or 
Reconfiguring a 
RAS Device

There are several different ways to start this procedure:
• If you have previously installed RAS and configured at least one RAS device, 

and are now adding or reconfiguring RAS devices, begin with Step 1.
• If you have previously installed RAS and were in the process of installing a 

modem when this process started automatically, begin with Step 3.
• If you were in the process of installing RAS when this process started 

automatically, begin with Step 5.
Follow these steps:
1. Open the Control Panel and double-

click the Network icon, or right-click 
on the Network Neighborhood and 
select the Properties button. The 
Network window appears.

2. Select the Services tab.
3. Highlight Remote Access Service and 

select the Properties button. 
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Adding or Reconfiguring a RAS Device
4. To reconfigure an existing RAS port, highlight the port/device and select the 
Configure button. Then go to Step 7.

5. To add a new RAS device—for 
example, if you are configuring a 
new modem—select the Add button. 
The Add RAS Device window 
appears:

6. Use the droplist to select the COM 
port (modem) that you want to 
configure and select the OK button.
Note: If no modems appear on this 

list, you need to install a 
modem, see Installing Modems.

The Remote Access Setup 
window reappears.

7. Highlight the desired 
COM port (Modem) and select the 
Configure button. The Configure Port 
Usage window appears.

8. Select the appropriate option, based 
on the role the modem will perform, 
and select the OK button. 
Note: When configuring multiple 

simultaneous RAS dial-in 
ports, configure the ports to “Receive calls only” not “Dial out and 
Receive.” Configuring a port to dial-out requires a separate memory pool 
for each dial-out port, while all ports configured for receive-only share 
the same memory pool.

If you configure too many ports for dial-out unnecessarily, resources can 
become an issue. If you require dial-out on the RAS server, configure one 
port to “Dial out and Receive” and all the other ports to “Receive calls 
only.”
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Adding or Reconfiguring a RAS Device
The Remote Access Setup 
window reappears. 

9. Highlight the COM port 
(modem) again and select the Network 
button.

10. Select the appropriate dial out protocols, 
dial in protocols, logon security levels, 
enable multilink (if required) and select 
the OK button
Note: Only previously configured protocols 

are selectable. If you want to set up a 
protocol that is grayed out, you must 
first add it using the Network 
Protocols tab.

If you selected “Receive calls only” on all 
ports while configuring the port usage, the 
“Dial out Protocols” area will be shaded.
If you want to use Multilink PPP 
(bonding), make sure that you select the 
Enable Multilink check box. 
For detailed information about the 
configuration windows, use the Help button or the Windows NT CD-ROM 
(Support/books/server.hlp file to locate information).

Note: The following steps are dependent upon the protocol selections made in this 
window.

11. If you select NetBEUI on the Network 
Configuration window, the following 
window appears. Make the appropriate 
selection for your environment and select 
the OK button. 
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12. If you select TCP/IP, the following window appears. Make the appropriate 
selections for your environment and press the OK button.

13. If you select IPX, the following window 
appears. Make the appropriate selection for 
your environment and select the OK 
button. 

14. Select the OK button to exit the Network 
Configuration window and return to the 
Remote Access Setup window.
Note: Choices made during network 

configuration will effect the entire 
system.

15. If you want to duplicate the configuration 
you just created on any other COM port 
(modem), highlight the COM port number 
and select the Clone button. Otherwise, repeat Steps 7 through 14 for each 
COM port (modem) you want to set up.

16. After setting up all the COM ports, select the Continue button.
17. Select the Close button at the Network/Services tab to complete the RAS 

installation.
18. Select the Yes button when asked to reboot the computer. Windows NT RAS 

installation is complete.
19. If necessary, install the latest NT Service Pack or Packs from Microsoft.
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Configuring Printers

Use this subsection to configure printers for the Comtrol device after installing the 
hardware and driver.

Adding Serial 
Printers

Follow these steps to configure a serial printer in Windows NT:
1. Connect the printer to the desired port. Use a DTE-to-DTE null modem cable 

unless the printer maker specifies otherwise.
2. Open the Printers control panel and double-click on 

the Add Printer icon. 
3. Select the My Computer check box, then the Next 

button.

4. If the desired COM port is on 
this window, select it, select on 
the Next button, and skip to 
Step 6.

5. If the desired COM port is not on this list, select the Add Port button and 
follow these steps:
a. A list of printer ports appears. Select 

Local Port.
b. Select the New Port button.
c. Type in the name of the port.

Note: Port names above COM9 require 
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the \\.\ prefix. For example, to reference COM12, enter \\.\COM12: 
(make sure that you add the colon)

d. Select the OK button. 
e. Select the Close button to return to the Add Printer Wizard.
f. Select the Next button.

6. Select the printer make and 
model and select the Next 
button. 
If your printer is not on the 
make and model lists, but you 
have a manufacturer-supplied 
printer diskette, select the 
Have Disk button.
If you have already installed 
another printer using this 
driver, you are asked if you 
want to keep the existing 
driver.

7. To keep driver: select Keep 
existing driver check box, select 
the Next button, and go to Step 8.
If you choose Replace existing driver, or if you have not previously installed this 
driver, you are prompted to insert either the Windows NT CD-ROM or the 
manufacturer’s printer diskette. Do so and select the Next button.

8. Select whether you 
want this printer 
to be the Windows 
NT default printer, 
and select on the 
Next button.

9. Select whether or 
not you want to 
share this printer 
with other 
computers on the 
network. If you 
select Shared, you 
are asked to 
indicate the 
operating systems 
of all the 
computers that 
will be sharing this 
printer. (You may 
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also be required to insert the operating system media so that Windows NT can 
extract the necessary driver files.)

10. Select whether to print a test page and select the Finish button.
You are now ready to begin using the printer. No reboot is needed.

Changing Printer 
Port Configuration

If the printer does not successfully print the test page, it may be necessary to 
change the port baud rate, parity, and so on. If the Ports wizard does not configure 
the port properly, you may have to use the mode command from a DOS prompt. 
Also check the printer for DIP switches or other hardware configuration options.

Changing Printer 
Port Assignment

To change the port assigned to a printer, follow these steps:
1. Open the Printers control panel.
2. Right-click on the icon for the printer you want to change.
3. Select the Properties option from the shortcut menu. The Properties window 

appears. 
4. Select the Ports tab.

Note: The Properties window also gives you access to printer test and setup 
options that can be very helpful when debugging a serial printer 
installation.

5. Check the port you want to switch to. Remember to change your cabling 
accordingly.
Note: The Configure button on the Ports tab does not recognize Comtrol ports. 

This is a limitation of Windows NT. If you need to reconfigure the port, 
use the Ports option on the Control Panel.

6. Select the OK button. Any changes you make take effect immediately. No 
reboot is needed.
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This section discusses the following utilities that are installed with most Comtrol 
drivers for Microsoft operating systems:
• Test Terminal program (wcom32.exe), which can be used to troubleshoot 

communications on a port-by-port basis (Using Test Terminal on Page 34).
• Port Monitor program (portmon.exe), which checks for errors, modem control, 

and status signals (Using Port Monitor on Page 37). In addition, it provides 
you with raw byte input and output counts.

• Peer Tracer program (peer.exe), which traces driver events (Using Peer Tracer 
on Page 42).

Using Test Terminal

WCOM32 is a terminal program that enables you to open a port, send characters 
and commands to the port, and toggle the control signals.
Note: WCOM32 will not work on ports used by RAS if Remote Access Service is 

running or any other application is using the port. If you are using RAS, 
you must stop the service before starting WCOM32 to test RAS COM ports. 
To test ports that are not used by RAS, you do not need to stop RAS.

Follow these steps:
1. Start Test Terminal (wcom32.exe) from the Comtrol program group for your 

product.

2. Select the OK button if this screen appears:

3. From the Port menu, select Open Port. A list of possible COM port numbers 
appears.

Product Operating 
System Program Group

RocketModem and 
RocketPort

Windows 98, 
Windows NT

Comtrol RocketPort RocketModem 
Test Terminal

RocketModem and 
RocketPort

Windows 2000, 
Windows XP

Comtrol Utilities Wcom32 
wcom32.exe

DeviceMaster RTS, 
RocketPort Serial Hub ia, 
and RocketPort Serial 
Hub Si

Windows 98, 
Windows NT, 
Windows 2000, 
Windows XP

Comtrol NS-Link Test Terminal
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4. Select the COM port you want to test.

If the COM port does not exist or if it is currently being used by another 
program, a Create File Error message appears.
If the COM port is available, a terminal window appears:   

Note: Notice the <loop> button in the terminal window. If this option is 
activated, it is green and uppercase ( ), the COM port internal 
loopback feature is activated, and the data is returned by the COM port 
hardware. If this option is deactivated, it is gray and lowercase ( ), 
the internal loopback is deactivated, and the data is sent out of the COM 
port.

Testing a Comtrol 
Device

Use the following procedure to test the Comtrol device.
1. Place a loopback plug on the COM port that you are testing. Make sure all 

connectors are seated firmly and that the loop button is off. 
Note: Test terminal works for RS-232 and RS-422 mode.
To build loopback plugs, see the hardware installation document for the 
Comtrol device.

2. From the Port menu, select Send Test Data. The program sends out a repeating 
data stream. 
Note: To stop the data stream, select the Send Test Data option again. 
• If the loopback plug is in place and the port is working correctly, the test 

data should be echoed back to the screen. 
• If the loopback plug is not in place or the port is not working correctly, no 

data or garbled data is echoed back to the screen. 
Note: If no characters appear, try putting the loopback plug on an adjacent 

port. It may be that you have the ports mixed up. 
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3. If further testing is required, select Loopback Test from the Port menu. 

If the loopback plug is in place and the port is 
working correctly, the system should return 
the message Passed.
If the loopback plug is not in place or the port 
is not working correctly, the system will return 
the message Failed. 

Testing a Comtrol 
Device (RS-485)

Perform the following procedure to determine if a port or ports are functioning 
properly.
1. Connect a straight-through cable from Port 1 to Port 2. 

Note: See the hardware installation document for the Comtrol device if you 
need to build a cable.
If testing ports other than Ports 1 and 2, simply connect the cable 
between any two ports.

2. Open a session for each port.
3. Enter data into the Port 1 session. The data should appear in the Port 2 

window.
4. Enter data into the Port 2 session. The data should appear in the Port 1 

window.
Note: If the data appears as described in Steps 3 and 4, the hardware is 

functioning properly.

Test Terminal 
Modem Control 
Signals

The terminal window displays the modem control signals as gray 
or green lights at the top of the window. The first four are inputs: 
The lights are green if they are turned on, or gray if turned off. 
The text on the light also changes from uppercase (CTS), which is on, to lowercase 
(cts), which is off.
The next two lights are outputs:  
Note: If you have a loopback plug connected and you click on one of the outputs, 

the corresponding signal is sent to the input and the input lights should 
toggle accordingly.

The right most light is the loop indicator:  
If this is on, the COM port internal loopback feature is activated and any 
information or code entered in the terminal window loops back through the COM 
port circuitry. If this is off, the COM port internal loopback is deactivated, and any 
information or code entered in the terminal window is sent out of the port.
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Using Port Monitor

The Port Monitor program (portmon.exe) offers a summary of all Comtrol device 
statistics in one spreadsheet view. It also enables you to verify operation of all 
Comtrol device ports from a single window. 
The Port Monitor display follows the familiar spreadsheet model: each COM port 
is a horizontal row, and each vertical column displays a variable or value for the 
respective COM port. For definitions of the abbreviations used, see Port Monitor 
Variables on Page 41.
Port Monitor can also produce statistics and reports that can help you verify the 
operation of the COM ports and connected peripherals. Some immediate feedback 
includes:
• The state of the modem control and status signals
• Open ports
• Raw byte input and output counts obtained from the device driver
• Port errors
The available statistics include:
• Instantaneous characters per second (CPS) calculations
• Minute, hour, and day CPS averages and peaks
• Carrier detect (CD) signal runtime and transition count
Reports can be automatically generated on an hourly and/or daily basis, and can 
cover all ports collectively or a separate report for each port. You can also set how 
often the values are recalculated, fine-tuning thoroughness against system 
efficiency, and automatically run external batch files to perform additional 
processing and analysis.

Starting Port 
Monitor

To run Port Monitor, select Port Monitor (or Portmon.exe) from the appropriate 
Comtrol program group. 

The Port Monitor window appears:

Note: To change the appearance of the window, see the following discussion.

Product Operating 
System Program Group

RocketModem and 
RocketPort

Windows 98, 
Windows NT

Comtrol RocketPort RocketModem 
Port Monitor

RocketModem and 
RocketPort

Windows 2000, 
Windows XP

Comtrol Utilities Portmon 
Portmon.exe

DeviceMaster RTS, 
RocketPort Serial Hub ia, 
and RocketPort Serial 
Hub Si

Windows 98, 
Windows NT, 
Windows 2000, 
Windows XP

Comtrol NS-Link Port Monitor
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Changing Screen Appearance
Once the monitor window appears, Port Monitor is active and collecting data. If 
any cumulative data has been saved from previous sessions, it is automatically 
brought in and used.
Port Monitor continues to run and collect data until you terminate it, at which 
point all accumulated data is automatically saved for use in the next session.

Changing Screen 
Appearance

While Port Monitor is running, there are a number of commands and controls that 
change the appearance of the screen.

* The Reset command does not clear raw data from the calcs.dat file. It simply 
resets the selected display fields to their null values. For more information 
regarding calcs.dat, see page 40.

Desired Change Procedure

Change the monitor 
window font. Select Font from the Edit menu.

Change width of a 
single column.

Click on the column separator (vertical) line and drag 
it to the desired width.

Change column 
placement.

Click in the middle of the column you want to move 
and drag it to the desired location.

Remove a column. Right-click on the column you want to remove and 
select Remove from the shortcut menu.

Clear all fields and 
reset them to null 
values.

Right-click on the upper left cell in the table and select 
Reset from the shortcut menu.*

Clear any single field 
except the upper left 
cell.

Right-click on the field to be cleared and select Reset 
from the shortcut menu.*

Add a column.

Right-click on the column now occupying the desired 
location and select Add from the shortcut menu.
You are prompted to name the variable you want to 
display, as well as other information. (See the 
following Column Setup discussion.) 
After you click OK, the column is inserted in the 
selected location and the existing column is moved to 
the right.

Change other properties 
of a column.

Right-click on the column and select Properties from 
the shortcut menu. (See Column Setup, below.)
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Column Setup When you select Add or Properties from the 
column shortcut menu, the Column Setup 
window appears: 
• Use the Input droplist to select the 

variable displayed in the column.
• Use the Type droplist to select the way in 

which the value displays: either as an 
integer, as an on/off state, as an integer 
with a kilo, mega, or giga suffix, or as an 
hh:mm:ss time stamp. This defaults to the 
appropriate type for the selected Input 
variable.

• Use the Name variable to change the 
column heading name.

• Use the Width variable to specify the column width in characters.
• Use Color0 to set the column character color when the value is zero.
• Use Color1 to set the column character color when the value is not zero.
• When you are done, click OK to save your changes and return to Port Monitor.

Report 
Configuration

To configure reports, select 
Config from the Edit menu. 
The Single report options cover 
all ports and are overwritten 
each time the reports are 
generated. The Multiple report 
options generate a separate 
report for each port, and each 
report file is appended each 
time the report is generated.
For Hour reports, use the Single 
and Multiple droplists to select 
whether you are generating 
single or multiple reports, or 
both. For each report type, 
select from the following types 
of data to include:
• None: no report is generated.
• Hour Data: only variables with “Hour” in the name are included.
• All Data: all variables are included.
• View Data: only variables that appear on-screen are included.
The External Program field is used to enter a command line to run another 
program after the hourly reports have been generated. For example, you can use 
this to run a batch file that performs custom report processing. The Test button 
causes the command line to be executed immediately.
For Day reports, the single and multiple droplists behave the same, but your 
choices are:
• None: no report is generated.
• Day Data: only variables with the words “Day” or “Raw” in the names are 

included.
• All Data: all variables are included.
• View Data: only the variables that appear in the Port Monitor window are 

included.
Likewise, the External Program field is used to enter a command line to be 
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executed after the daily reports have been generated.
The Update Time option allows you to set the rate at which the port information is 
obtained and the calculations performed. There is a trade-off between Port 
Monitor efficiency and response time. If you are using Port Monitor to view the 
port activity on the screen, you may want to set the update time to 1 or 2 seconds, 
so that the screen is updated frequently. If you are concerned about the monitor 
program using CPU resources, set this to a higher value, (6 to 20 seconds) in order 
to decrease the time required by the program to perform the calculations and 
update the screen.
If Port Monitor is left active to generate reports, minimizing or reducing the 
display area of the program will help reduce the CPU overhead of updating the 
screen.

Port Monitor Files Port Monitor creates and uses the following files:
• portmon.vew

• calcs.dat

The default column layout is saved in portmon.vew. If you have been experimenting 
with the appearance of the monitor screen, you can use the Save option from the 
File menu to save your customized layout in another.vew file. You can retrieve this 
file later by selecting the Open option from the File menu, or you can select the 
View Default option from the Edit menu to retrieve portmon.vew and restore the 
default view.
All Port Monitor calculations are saved at program exit and on the hour in a 
binary file named calcs.dat. This enables you to halt Port Monitor execution 
without losing accumulated data.
Port Monitor also creates a \REPORTS directory. All hourly and daily reports are 
saved in this directory, under the following names:
• hall.txt — hourly single report
• dall.txt — daily single report
• hcomx.txt — hourly multiple reports, where x is the port number
• dcomx.txt — daily multiple reports, where x is the port number
Caution: Since multiple reports append new data each time they are written, the 

multiple report files grow in size. It is up to you to delete them 
periodically.

Some safeguards are built into the program to avoid filling up a hard disk drive 
due to growing report files. The monitoring program stops writing additional data 
to the multiple reports if they reach a size of 2 MB. Also, the program will not 
write out data files to the disk drive if the spare room on the drive is less than 2 
MB in size.
To view or edit an hourly or daily report, select the Edit Report option from the 
File menu, or use a system tool such as Microsoft Notepad.
For more information, see the Port Monitor Help file.
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Port Monitor 
Variables

The following table lists Port Monitor variables. 

Variable Description

Open Open status, on if open, off if closed.

Cts Input CTS pin status.

Dsr Input DSR pin status.

Cd Input CD (carrier detect) pin status.

Rts Output RTS pin status.

Dtr Output DTR pin status.

TxTotal Total bytes transmitted.

RxTotal Total bytes received.

TxCPSInst Instantaneous average of transmit characters per 
second.

RxCPSInst Instantaneous average of receive characters per 
second.

Errors Total hardware receive errors (parity, framing, and 
overruns.)

TxMinCPS Last minute average of transmit characters per 
second.

RxMinCPS Last minute average of receive characters per 
second.

TxCPSMinAvMax Peak TxCPSInst for the last minute.

RxCPSMinAvMax Peak RxCPSInst for the last minute.

TxCPSHourAvMax Peak TxMinCPS for the last hour.

RxCPSHourAvMax Peak RxMinCPS for the last hour.

TxCPSDayAvMax Peak TxMinCPS for the last day.

RxCPSDayAvMax Peak RxMinCPS for the last day.

TxTotalRaw Total number of transmit bytes raw data from the 
device driver.

RxTotalRaw Total number of receive bytes raw data from the 
device driver.

TxMinCnt Count of transmit bytes sent in last minute.

TxHourCnt Transmit bytes count sent in the last hour.

TxDayCnt Transmit bytes count sent in the last day.

RxMinCnt Receive bytes count sent in the last minute.

RxHourCnt Receive bytes count sent in the last hour.

RxDayCnt Receive bytes count sent in the last day.

TxMinCntWrk Transmit bytes count sent in this minute.

TxHourCntWrk Transmit bytes count sent in this hour.

TxDayCntWrk Transmit bytes count sent in this day.

RxMinCntWrk Receive bytes count sent in this minute.

RxHourCntWrk Receive bytes count sent in this hour.

RxDayCntWrk Receive bytes count sent in this day.
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Using Peer Tracer

The Peer Tracer program (peer.exe) is specifically designed to view the internal 
operations of the device driver for the purpose of troubleshooting communications 
on Windows NT, Windows 2000, and Windows XP systems. Peer enables you to see:
• Receive and transmit data
• Internal driver event traces
• Advanced configuration and status information
Like Test Terminal, Peer acts as a simple terminal session, and is used to send and 
receive text information to and from the device driver. To use Peer, you type in 
commands, and status and information are sent back.
Unlike Test Terminal, Peer enables you to keep a continuous log of the commands 
sent and the results received in a file named peer.log. Comtrol Technical Support 
may ask you to run Peer in order to help diagnose reported problems.

TxCPSMinAvMaxWrk Peak TxCPSInst for the current minute.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.

TxCPSDayAvMaxWrk Peak TxHourCPS for the current day.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.

RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.

RxCPSDayAvMaxWrk Peak RxHourCPS for the current day.

CDRuns Carrier detect turn-on count.

CDDayRuns Carrier detect turn-on count in the last day.

CDDayRunsWrk Carrier detect turn-on count in the current day.

CDRunTime Time in seconds carrier detect has been on.

CDHourRunTime Time in seconds carrier detect has been on in the 
last hour.

CDDayRunTime Time in seconds carrier detect has been on in the 
last day.

CDHourRunTimeWrk Time in seconds carrier detect has been on this hour.

CDDayRunTimeWrk Time in seconds carrier detect has been on this day.

StatusFlags Bit flags, Open, CTS, DSR, CD, RTS, DTR

TxPkts Raw count of total transmit packets sent.

RxPkts Raw count of total receive packets sent.

OverrunErrors Total count of receive overrun errors.

FramingErrors Total count of receive framing errors.

ParityErrors Total count of receive parity errors.

OverrunErrorsRaw Total count of receive overrun errors, from the 
device driver.

FramingErrorsRaw Total count of receive framing errors, from the 
device driver.

ParityErrorsRaw Total count of receive parity errors, from the device 
driver.

Variable Description
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Starting Peer Peer Tracer does not appear in most Comtrol program groups and you may need to 
start the application from the Windows Explorer. Use the table below to determine 
whether you can start Peer from a program group or where to locate the 
executable. 

To start Peer, you may need to open 
the Windows Explorer, access a 
specific directory, and double-click 
on peer.exe or start peer using the 
Comtrol Utilities program group. 
The Peer Tracer window displays (at 
right). 

Log Functions All logging functions are found under the File menu. To start keeping a log, select 
Log to Disk from the File menu. The other options on this menu are View Disk Log, 
Clear Disk Log, Clear Screen, and Exit.

Using Peer To use peer, simply type in commands at the : prompt. (It may be necessary to 
press Enter to make the : prompt appear.) For example, to examine COM5, type: 
PORT COM5 <Enter>

To gather some information about the port, type: STAT <Enter>. This should 
return details about the port.
To turn on monitoring of any calls into driver (events), type: MON EV <Enter>

To send strings and commands to attached peripherals—for example, to send 
“ATH0” to a modem—type: SEND ATH0 <Enter>. A return and line feed are always 
appended to each string sent.

Other Peer 
Commands

Enter commands at the : prompt and follow each command with Enter.

Keep in mind that all commands are processed in the device driver, and that Peer 
simply acts as a conduit for this information. 
For more information, see the Peer.hlp help file.

Product Operating 
System Starting Peer

DeviceMaster RTS, 
RocketPort Serial Hub ia, 
RocketPort Serial Hub Si

Windows NT, 
Windows 2000, 
Windows XP

\WINNT\system32\rpshSi\peer.exe

RocketModem and 
RocketPort Windows NT \WINNT\system32\rocket\Peer.exe

RocketModem and 
RocketPort

Windows 2000, 
Windows XP Comtrol Utilities peer.exe

Command Effect

MON TX Monitor data being transmitted through the selected port.

MON RX Monitor data being received through the selected port.

M Turn off all monitoring.

? Display Peer Tracer command summary.

PORT COMxx Change port being examined to COMxx.
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Troubleshooting and Technical Support

This section contains troubleshooting information for your Comtrol device. You 
should review the following subsections before calling Technical Support because 
they will request that you perform many of the procedures or verifications before 
they will be able to help you diagnose the problem.

Troubleshooting

If you are having trouble with a RocketPort or RocketModem, try the following.
Note: Most customer problems reported to Technical Support are traced to cabling 

or network problems.
1. Follow the instructions in the Hardware Installation document to run the 

Diagnostic and verify that the hardware is working correctly, independently of 
the driver and operating system.

2. Make sure the adapter is seated firmly in the expansion slot and that the 
expansion slot screw is in place. Also, try moving the adapter to another slot, if 
one of the correct bus type is available, and rerunning the Diagnostic.
Note: If the board fails to pass the Diagnostic, stop now and contact Comtrol 

Technical Support. All of the following steps assume that the board is 
functional and that the problem is either a configuration or connection 
issue.

3. Verify that you are using the correct types of cables in the correct places and 
that all cables are tightly connected.

4. If you have an ISA adapter, make sure that you set the I/O DIP switch 
correctly.

5. Enable the Verbose Event Log feature under the Setup Options tab and then 
reboot the server.

6. Verify that you are addressing the port correctly. In many applications, device 
names above COM9 require the prefix \\.\ to be recognized. For example, to 
reference COM20, use \\.\COM20 as the file or port name.

7. Verify that you have obtained and installed all Microsoft service packs for your 
operating system.

8. Verify that you have obtained and installed the latest Comtrol driver for your 
adapter and operating system. Current versions of all Comtrol drivers can be 
downloaded at no charge from the Comtrol ftp/web sites.

9. Verify that you are using the correct ports. The RocketPort 8J 
mounting bracket and port numbering scheme are shown in 
the illustration at right. The port on the “top” edge of the card 
is Port 1, and the port at the “bottom” edge of the card, 
nearest the bus connector, is Port 8.
RocketPort and RocketModem products use a variety of 
mounting brackets, and in some cases unused ports may be 
blocked with dummy plugs, but in all cases, the port or 
modem at the “top” edge of the adapter is Port or Modem 1.

10. If you are using ISA-bus adapters, verify that the DIP 
switches on the adapters are set as described in the hardware 
installation instructions and the base I/O addresses in the 
Device Setup window are set as described under Changing or 
Viewing Adapter Configuration.

1
2
3
4
5
6
7
8

Port
Troubleshooting and Technical Support 44 



Device Driver and OS Capabilities and Limitations
11. If you are using a PCI-bus adapter, check the Summary in the Device Setup 
window to verify that the correct bus type was selected during installation.

12. Use the Main Setup Options to reset the Scan Rate to 10 ms.
13. Remove the driver and reinstall it, using a different I/O address (ISA-bus 

adapters only).
14. If your RocketModem model supports the reset function, use the Reset function 

(page 21) to reset the modem to its default (power-on) state.
15. Use the Test Terminal program (wcom32.exe) to troubleshoot communications 

on a port-by-port basis.
16. Use the Port Monitor program (portmon.exe) to check for errors, modem 

control, and status signals. In addition, it provides you with raw byte input 
and output counts.

Device Driver and OS Capabilities and Limitations

This device driver supports the Win32 API. The following tables list known device 
driver and operating system capabilities and limits. This information is not 
relevant to ordinary users, but is important to software developers.
Note: In Windows NT, device names above COM9 require the \\.\ prefix in order 

to be recognized by the system. For example, to reference COM20, use 
\\.\COM20 as the file name.  

Device Control Block 
Settings Status

BaudRate Variable depending on RocketPort or RocketModem 
model installed

ByteSize 7 or 8

ErrorChar Supported

EofChar Not supported, supports only binary

EvtChar Supported

fAbortOnError Supported

fBinary Always binary mode

fDtrControl Supported

fDsrSensitivity Not supported

fErrorChar Supported

fInX, fOutX Supported

fNull Supported

fParity Supported

fOutxCtsFlow Supported

fRtsControl
RTS_CONTROL_DISABLE, 
RTS_CONTROL_ENABLE,
RTS_CONTROL_HANDSHAKE, 
RTS_CONTROL_TOGGLE

fTXContinueOnXoff Supported as always TRUE

Parity EVENPARITY, NOPARITY, or ODDPARITY

StopBits ONESTOPBIT or TWOSTOPBITS
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Before calling Technical Support
 

Before calling 
Technical Support

Comtrol has a staff of support technicians available to help you. 
You should review Troubleshooting and run through the diagnostics before calling 
Technical Support. In addition, the web site has On-Line Technical Support 
available. If you call for Technical Support, please have the following information 
available.

XonChar, XoffChar Supported

Unsupported IOCTL 
Functionality Status

IOCTL_SERIAL_XOFF_COUN
TER Not supported

IOCTL_SERIAL_SET_HANDF
LOW
(unsupported options)

SERIAL_DSR_HANDSHAKE, 
SERIAL_DCD_HANDSHAKE, 
SERIAL_DSR_SENSITIVITY

IOCTL_SERIAL_GET_COMM
STATUS
(unsupported options)

fDsrHold, fRlsdHold

Device Control Block 
Settings Status

Item Information

Hardware Type 

Hardware Serial Number*

Operating system type

Driver part number and revision level of 
Rocket.sys

Server computer make, model, and speed

Other serial port adapters installed in the 
server and their COM port numbers

Devices connected to the board
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Technical Support
Technical Support

If you need technical support, contact Comtrol using one of the following methods.

Contact 
Method

Corporate 
Headquarters Comtrol Europe

FAQ/Online http://support.comtrol.com/support.asp

Downloads http://support.comtrol.com/download.asp

Email  support@comtrol.com support@comtrol.co.uk

Web site  http://www.comtrol.com http://www.comtrol.co.uk

Fax (763) 494-4199 +44 (0) 1 869-323-211

Phone (763) 494-4100 +44 (0) 1 869-323-220
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